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Introduction: 
 
Learning to think. Learning to learn. These are the essential skills for student success. 
Scientifically based research and educational theory tell us that visual learning techniques – 
graphical ways of working with ideas – are among the best methods for teaching students 
how to think and learn. The use of graphic organizers helps students develop important 
comprehension, thinking and writing skills – all skills necessary to meet the Common Core 
State Standards, and success in life.  
 
Inspiration® 9, a product of Inspiration® Software, Inc., is the ultimate thinking and learning 
tool for students and educators. In Inspiration, you think and learn visually. Inspiration allows 
you to create a picture of your ideas and concepts in the form of a diagram of mind map. It 
also provides an integrated outlining environment for developing your ideas into organized 
written documents. Inspiration stimulates both visual and linear thinking to deepen 
understanding of concepts, increase memory retention, develop organizational skills and tap 
creativity.  
 
The following lessons intended to be used in conjunction with Inspiration 9 on a Mac or 
Windows computer. If you do not already have Inspiration 9 in your classroom, you can 
download a free 30-day trial at www.inspiration.com/freetrial. If you are interested in 
purchasing Inspiration 9, go to www.inspiration.com/resellers to locate a reseller near you. 
 
Teach your students invaluable thinking skills with the help of Inspiration 9 and these lesson 
plans.  
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Essay	
  Planning	
  and	
  Writing	
  
Lesson	
  Plan	
  

 
 
Subject Areas: English/Language Arts and Social Studies 
 
Grade Level: 6 – 12 (ages 11-18) 
 
Time: At least three 45-minute class periods; time outside of class as necessary 
 
Lesson Objective: 
Students will be better able to plan, organize and compose effective essays. 
 
Common Core State Standards1: 

Writing Standards for Grades 6-12 in English Language Arts & Literacy in History/Social Studies, 
Science, and Technical Subjects 

Standard 5. Develop and strengthen writing as needed by planning, revising, editing, 
rewriting, or trying a new approach.  

Standard 6. Use technology, including the Internet, to produce and publish writing and to 
interact and collaborate with others.  

 
Overview: 
Writing essays is much easier with the right tools. Download the Essay (Inspiration Starter> Learn 
to Use> Examples>Language Arts> Essay Planner) to use with your students to help them 
organize their ideas and break the writing process down into manageable steps.  

 

 
 
Preparation: 

• This lesson requires the Inspiration® software application published by Inspiration Software, 
Inc. 30-day trials can be downloaded at <http://www.inspiration.com/Inspiration>. 

• This lesson requires the following Inspiration documents and templates: 
o Essay Planner template, which can accessed from inside Inspiration at Inspiration 

Starter> Learn to Use> Examples>Language Arts> Essay Planner. 
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o Writing Process template, which can be accessed from inside Inspiration at Inspiration 
Starter> Templates> Language Arts>Writing Process 

o Essay Planner Example, which can be accessed from inside Inspiration at Inspiration 
Starter> Learn to Use> Examples>Language Arts>Essay Planner 

§ Please note: The template and example referenced in this lesson are web-
based and only available if your computer is connected to the Internet. If you 
are not connected, you can create a similar example in Inspiration®. 

• Access to library resources and/or the Internet would also be helpful for student research. 
 
Lesson:   

1. Explain that writing is a 
process involving many 
steps. Open the Writing 
Process template 
(Inspiration Starter> 
Templates>Language 
Arts>Writing Process) 
and discuss the steps 
with students in detail: 
prewriting, drafting, 
revising, editing and 
publishing.  

 
 
 
 
 
 
 
 
 

2. Explain that Inspiration offers many other tools and templates to help with the writing process, 
including the integrated Word Guide and the Essay Planner template which they will use 
today. Open it, as shown on the previous page, and explain the areas of the template to the 
students. 

 
3. Open the Essay Planner 

Example (Inspiration Starter> 
Learn to Use> 
Examples>Language 
Arts>Essay Planner) so 
students have an idea of a 
finished diagram. Be sure 
students understand that they 
will develop this plan for their 
essay before they begin to 
write it in paragraph form. 
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4. Prewriting: Have students choose a general topic to begin writing about and record it in the 
space provided. Then they can brainstorm ideas about it in a blank area to the side of the 
diagram using the RapidFire® tool. 

a. How to use Rapidfire: Select an existing idea symbol in the diagram and then click the 

Rapidfire button  on the Main toolbar. Type an idea and then click Return or Enter 
to quickly add a new idea. 

 
5. When students have a topic they like, they should continue the prewriting process by 

developing a working thesis statement. Explain that a thesis statement is normally one 
sentence that states what one will attempt to argue in the paper. Explain that it is called a 
“working” thesis statement because it may change as students conduct their research. 

 
6. Students can complete the diagrams and go to Outline View to start their essay draft and 

finish reorganizing their essay.  
 

 
 

7. After students have organized their work in outline form, they can transfer their projects to a 
word processor using the Transfer tool. This will allow them to complete the remaining steps 
in the essay writing process (revising, editing and publishing).  

 
Adaptations / Extensions: 

• See The Writing Process Made Easier lesson plan for more details on how to use Inspiration 
to help students master the writing process. 
 

• In addition to writing formal essays, students can “publish” their work by making an oral 
presentation to the class about their topic. They can use Inspiration’s Presentation Manager 
to add key talking points and visuals to their content. See the Thinking and Planning lesson 
plans Creating Oral Presentations I and Creating Oral Presentations II for more information 
about this process. Teaching the class will help them to clarify and better remember the 
content.  
 

• After presenting, students can answer questions and facilitate a discussion about the topic. 
 

• Rather than complete a formal essay in paragraph form, students can submit a completed 
diagram or a completed outline. 

 
• This lesson can be used in any content area that requires students to write essays.  

 
1 © Copyright 2010. National Governors Association Center for Best Practices and Council of Chief State School 
Officers. All rights reserved. Learn more online at <http://www.corestandards.org>.  
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Visualizing	
  Vocabulary	
  
Lesson	
  Plan	
  

 
 
Subject Areas: All subject areas 
 
Grade Level: 6 – 12 (ages 11-18) 
 
Time: At least one 45-minute class period; time outside of class as necessary 
 
Lesson Objective: 
Students will be better able to understand and recall a vocabulary word. 
 
Common Core State Standards1: 

Reading Standards for Grades 6-12 in English Language Arts & Literacy in History/Social Studies, 
Science, and Technical Subjects 

Standard 4. Interpret words and phrases as they are used in a text, including determining 
technical, connotative, and figurative meanings, and analyze how specific word 
choices shape meaning or tone. 

Writing Standards for Grades 6-12 in English Language Arts & Literacy in History/Social Studies, 
Science, and Technical Subjects 

Standard 6. Use technology, including the Internet, to produce and publish writing and to 
interact and collaborate with others.  

 
Overview: 
Creating visual representations of knowledge leads to deeper cognitive processing and greater 
retention of information. Use the Vocabulary Word template (Inspiration Starter>Templates> 
English Language Arts>Vocabulary Word) with your students to help them study vocabulary. 
Students can use mind mapping in Inspiration®’s Map View to help them explore definitions, 
synonyms, antonyms, word origin and sentence context, and to create visual cues for each word. 
Mind maps have an organic appearance, like a tree with many branches. They are quick to create 
because the structure is always the same and Inspiration’s mind mapping tools are efficient to use. 
With a central trunk (main idea), the thickest branches are main subtopics, and the thinner 
branches are subtopics of those. These visual cues help students as they mind map prior 
knowledge about a word and build new knowledge related to it. 
 
Preparation: 

• This lesson requires the Inspiration software application published by Inspiration Software, Inc. 
30-day trials can be downloaded at <http://www.inspiration.com/Inspiration>. 

• This lesson requires the following Inspiration documents and templates: 
o Vocabulary Word template, which can be accessed inside Inspiration at Inspiration 

Starter>Templates> English Language Arts>Vocabulary Word 
o Vocabulary Word Mind Map Example, which can be accessed inside Inspiration at 

Inspiration Starter>Examples>Language Arts>Vocabulary Mind Map 
• Access to library resources and/or the Internet would also be helpful for student research. 
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Lesson: 
1. Explain that with Inspiration students 

can mind map or diagram a 
vocabulary word by adding text and 
symbols to represent words and ideas 
visually. Open the Vocabulary Word 
template (Inspiration 
Starter>Templates> Language 
Arts>Vocabulary Word) and show 
the different areas of the template to 
the students. Provide clear directions 
about the sentences. For example, 
you might require one vocabulary sentence to be quoted from a common class text and one to 
be the student’s original creation to demonstrate that they know how to use the word in 
context. 

 
2. Open the Vocabulary Word Mind Map Example (Inspiration Starter>Examples>Language 

Arts>Vocabulary Mind Map) so students have an idea of a finished diagram. Please note: The 
example is web-based and only available if your computer is connected to the Internet. If you 
are not connected, you can create a similar example in Inspiration. Point out the use of symbols 
which add visual meaning and make information easier to remember. Be sure that students 
know how to use the Symbol libraries and the Hyperlink tool for definitions.  
 

	
  
	
  

Please note: The example is web-based and only available if your computer is connected to 
the Internet. If you are not connected, you can create a similar example in Inspiration. 

 
3. Students can complete their own mind maps or diagrams for vocabulary words. They can use 

the Symbol libraries to replace the central image with a symbol that provides a visual cue for 
the vocabulary word. They can use the links provided on the diagram to research synonyms, 
antonyms and the origins of the word, and use Notes and/or switch to Outline View to add 
details. 
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Adaptations / Extensions: 
• Students can create mind maps or diagrams of different words, then “publish” their work by 

making brief presentations to the class about their words. To create a presentation including 
visual talking points and elements of their mind maps, students can use the integrated 
Presentation Manager. See the Thinking and Planning lesson plans Creating Oral 
Presentations I and Creating Oral Presentations II for more information about this process. 

• Students can print out their diagrams for home study of the vocabulary words. Alternatively, 
flashcards could be prepared by printing just the words and central visual cues on one side of 
a piece of paper and the complete diagram on the other. 

• This lesson can be used in any content area that requires students learn new vocabulary. 
 

1	
  © Copyright 2011. National Governors Association Center for Best Practices and Council of Chief State School 
Officers. All rights reserved. Learn more online at <http://www.corestandards.org>. 
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Lab	
  Reports	
  Made	
  Easier	
  
Lesson	
  Plan	
  

 
 
Subject Areas: Science 
 
Grade Level: 7 – 12 (ages 12-18) 
 
Time: At least two 45-minute class periods; time outside of class as necessary 
 
Lesson Objective: 
Students will be able to organize and write an effective lab report. 
  
Common Core State Standards1: 

College and Career Readiness Anchor Standards for Writing: 
Standard 6. Use technology, including the Internet, to produce and publish writing and to 

interact and collaborate with others. 
Standard 7. Conduct short as well as more sustained research projects based on focused 

questions, demonstrating understanding of the subject under investigation. 
 
Overview: 
Use the Lab Report template to provide your students with a helpful framework for preparing a lab 
report (Inspiration Starter>Starter Docs>Science>Lab Report). As students prepare their reports in 
a visual format, they will develop diagrams, which will help them gain deeper understanding and 
demonstrate their knowledge.  
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Preparation: 
• This lesson requires the Inspiration® software application published by Inspiration Software, 

Inc. 30-day trials can be downloaded at <http://www.inspiration.com/Inspiration>. 
• This lesson requires the following Inspiration documents and templates: 

o Lab Report template, which can be accessed from inside Inspiration at Inspiration 
Starter>Starter Docs>Science>Lab Report 

o Lab Report example, which can be accessed from inside Inspiration at Inspiration 
Starter>Examples>Science>Lab Report 

• Preparations for the lab, as necessary. 
• Access to library resources and/or the Internet would also be helpful for student research. 

 
Lesson:   

1. Open the Lab Report template shown on the previous page and ask students about the 
various steps. For example, what is the “purpose” in a lab report? Demonstrate for students 
how they can open the notes at each step of the process if they need help as they write their 
reports.  

 
2. Open the example file (Inspiration Starter>Examples>Science>Lab Report) so they can 

see an example of a completed diagram. Be sure students know how to access the example 
as an additional resource as they prepare their own. 

 

 
 
3. Have students choose a lab partner and conduct the lab you have prepared; ask them to take 

notes on all of the steps and record the data. 
 
4. As the groups finish the lab, they can open the Lab Report template and complete the 

diagram, or if laptop computers are available, they can record their notes directly on the 
diagram as they work through the lab. 

 
5. Partners can work together and obtain feedback from the teacher on their diagrams. 
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6. Encourage students to use the Note tool to record details. They can go to Outline View to add 
more details and start their lab report draft.  

 

 
 

7. When they are ready to finish writing their report, students can transfer their projects to a word 
processor using the Transfer tool.  

 
8. Lead a class discussion about the students’ findings. What interesting discoveries did they 

make during the lab and while analyzing the data? Why is it important to follow the proper 
procedures when preparing a lab report? 

 
 
 

Adaptations / Extensions: 
• Instead of writing formal lab reports, student teams may be given the option to “publish” their 

work by making an oral presentation to the class about their results and conclusions. They can 
use Inspiration’s new Presentation Manager to add key talking points and visuals to their 
content. See the Thinking and Planning lesson plans Creating Oral Presentations I and 
Creating Oral Presentations II for more information about this process. Teaching the class will 
help them to clarify and better remember what they learned.  
 

• Explain the scientific method to students and ask them to compare their process of writing a 
lab report with the overall scientific method. Why is this method used by scientists all over the 
world? 

	
  
	
  
	
  
	
  
	
  
1 © Copyright 2010. National Governors Association Center for Best Practices and Council of Chief State School 
Officers. All rights reserved. Learn more online at http://www.corestandards.org. 
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Investigating	
  a	
  Place	
  in	
  Time	
  
Lesson	
  Plan	
  

 
 
Subject Areas: Social Studies, English/Language Arts 
 
Grade Level: 6 – 12 (ages 11-18) 
 
Time: At least two 45-minute class periods; time outside of class as necessary 
 
Lesson Objective: 
Students will research a place and time in history and create mind maps to help them better organize, 
synthesize and analyze the information. 
 
Common Core State Standards1: 

College and Career Readiness Anchor Standards for Reading: 
Standard 7. Integrate and evaluate content presented in diverse media and formats, 

including visually and quantitatively, as well as in words. 
College and Career Readiness Anchor Standards for Writing: 

Standard 1. Write arguments to support claims in an analysis of substantive topics or texts 
using valid reasoning and relevant and sufficient evidence. 

Standard 6. Use technology, including the Internet, to produce and publish writing and to 
interact and collaborate with others. 

 
Overview: 
Make the process of studying a place and time in history more manageable with the integration of 
visual learning. This lesson uses the Place in Time template (Inspiration® 
Starter>Templates>Social Studies>Place in Time) to help students research, organize and 
synthesize information about a place in time. They can focus on areas such as daily life, commerce, 
events, people and politics. If possible, use local places to make the assignment especially engaging 
for students, and provide them with opportunities to conduct original research within their 
communities. 
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Preparation: 
• This lesson requires the Inspiration software application published by Inspiration Software, Inc. 

30-day trials can be downloaded at <http://www.inspiration.com/Inspiration>. 
• This lesson requires the following Inspiration documents and templates:  

o Place in Time template, which can be accessed from inside Inspiration at Inspiration® 
Starter>Templates>Social Studies>Place in Time 

o Place in Time example, which can be accessed from inside Inspiration at Inspiration 
Starter>Learn to Use>Examples>Social Studies>Place in Time 

§  Please note: The templates and examples referenced in this lesson are web-
based and only available if your computer is connected to the Internet. If you 
are not connected, you can create a similar example in Inspiration®. 

• Access to library resources and/or the Internet would also be helpful for student research. 
 

Lesson:   
1. Tell students that they will research a place in history and use Inspiration to help organize their 

notes and thinking. For example, if you are studying the colonial period in U.S. history, you 
could have students choose one of the original settlements or colonies to research. Open the 
Place in History template shown on the previous page, and talk students through it so they 
understand the assignment. Explain that students could make their own mind maps from 
scratch, but using the template may help them get started and organize their research. 

  
2. Open the example file (Inspiration Starter>Learn to Use>Examples>Social Studies>Place 

in Time), and talk the students through it, as well, so they know what is expected.  
 

 
 

3. Explain to students that they will be adding visual Symbols, as well as text, to their mind 
maps. Students can use the Symbol libraries and search or insert images from external 
sources by copying and pasting them or inserting them via the Edit menu. Adding symbols will 
help them and those who view their mind maps to better understand and remember the 
content.  
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4. Inform students they can use Notes to add additional information as they complete the project. 

They can go to Outline View to finish organizing the information and start writing a draft if you 
require a written paper.  

 
 

 
 
5. Organize students into groups of 2-3 to complete the project. Groups will then choose a place 

in history to research. You may want to provide a list of acceptable topics, or you may have 
groups choose a place and then submit their proposals to you for review.  

 
6. Encourage students to add Hyperlinks to their sources of information, including any 

multimedia files available on the Internet. 
 
7. Have student groups make presentations to the class about their place using the integrated 

Presentation Manager. See the Thinking and Planning lesson plans Creating Oral 
Presentations I and Creating Oral Presentations II for more information about this process. A 
data projector or interactive whiteboard should be used, if one is available, to display graphics 
and visual talking points. 
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Adaptations / Extensions: 
• Completed mind maps can also be used as visual aids during oral presentations. 

• Notes can be turned on and off by clicking the Note Quick Control   in the upper-
right corner of the icon with the note. 

• Subtopics can be hidden or viewed using the Subtopic Quick Controls  to allow 
focused discussion on each topic during the presentation. 

 
• Students can develop a thesis statement and write a report on a specific place in history.  For 

example, their thesis statement could relate to the similarities and differences between the 
place in history and their own place and time. They can transfer their project to a word 
processor using the Transfer tool to complete the writing process. Be sure to point out to 
students that written essays are usually more formal than speeches. Therefore, students 
should avoid the first and second person. A formal Works Cited and parenthetical 
documentation also become that much more important. 

 
• Modify the assignment by changing the topics to be researched on the template. The template 

can also be simplified by removing some of the areas or adding more areas to be researched. 
Modified templates can be shared with some or all members of the class using the 
collaboration tools. 

 
• Inspiration may be used to create timelines of important developments in the history of the 

place. The Chronology template is useful for this extension (Inspiration 
Starter>Templates>Social Studies>Chronology).  

 
 
 
	
  
1 © Copyright 2010. National Governors Association Center for Best Practices and Council of Chief State School 
Officers. All rights reserved. Learn more online at <http://www.corestandards.org>. 
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Brainstorming	
  Visually	
  
Lesson	
  Plan	
  

 
Subject Areas: All subjects 
 
Grade Level: 6 – 12 (ages 11-18) 
 
Time: At least two 45-minute class periods; time outside of class as necessary 
 
Lesson Objective: 
Students will use visual brainstorming techniques to help them generate ideas, record what they know 
about a topic, identify questions for further inquiry, and support the research and writing process.  
  
Common Core State Standards1: 

College and Career Readiness Anchor Standards for Writing: 
Standard 6. Use technology, including the Internet, to produce and publish writing and 
 to interact and collaborate with others. 
Standard 7. Conduct short as well as more sustained research projects based on focused 

questions, demonstrating understanding of the subject under investigation. 
 

Overview: 
This lesson introduces visual brainstorming techniques using Inspiration® to students, with the goal of 
helping them generate ideas and record what they know about a topic, which should lead to questions 
for further inquiry. Students will use the diagrams they start during the brainstorming process to help 
them record and organize the information they gather through their research, and then switch to 
Outline View to seamlessly continue the writing process. 
 
Preparation: 

• This lesson requires the Inspiration software application published by Inspiration Software, Inc. 
30-day trials can be downloaded at <http://www.inspiration.com/Inspiration>. 

• Ensure ready access to library resources and/or the Internet for student research. 
 

Lesson:  
1. Tell students that today they will have the opportunity to start investigating a research topic or 

question of their choice, and that they will be using Inspiration to help them generate possible 
topics and complete the project. Show students how they can open Inspiration and click the 
Diagram button on the Inspiration Starter screen to start a new document in Diagram View. 

 

 
 

2. Tell students that in a moment you will ask them to suggest topic ideas for an example the 
class could brainstorm together before they begin a project of their own. They could even 
compare multiple topics, such as the Ancient Greeks and Romans, or the two novels Hatchet 
and Island of the Blue Dolphins. Type “Possible Topics” in the “Main Idea” symbol, and then 
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show students how they can quickly record their ideas by choosing the RapidFire® tool from 
the Main toolbar. Point out how the red lightning bolt now appears next to the text on the 
symbol to indicate that RapidFire is active. 
 

 
 
3. Explain to students that when they brainstorm they shouldn’t worry about how good their ideas 

are: the goal is simply to record ALL of their ideas as quickly as possible. With that in mind, 
have students shout out ideas for possible topics. Type each idea and hit Enter (Windows) or 
Return (Mac) between each one. When the ideas slow down, try to reach consensus as a 
class about which topic to use as an example. If two topics are particularly interesting, tell 
students that a great project can be to compare two things, so they may choose them both if it 
would be appropriate for your subject and grade level. 

 
4. Show students how to start a new diagram by clicking File>New. 

Type the chosen topic into the “Main Idea” symbol, and if two 
topics were chosen, use Point and Type (another easy way to 
record thoughts) to type the second. Just point to any place on 
the diagram, click the mouse button and start typing. Tell 
students that they will now brainstorm everything they know 
about the topic or topics and possible areas for further research. 
For example, “Conserve Energy” could be the topic, and with 
RapidFire the class could quickly record their ideas. Ask for a 
volunteer to record the ideas that are brainstormed this time, such as those shown to the right. 

 
5. After a few ideas are recorded, explain that sometimes it 

is better to brainstorm without links, so it is easier to 
classify ideas and connect them later. Point out for the 
volunteer and the rest of the students how to click the 
down arrow on the right side of the RapidFire button and 
select Without Links from the drop-down menu. Explain 
that they can brainstorm ideas first and use Links at a 
later time to identify relationships between ideas. In this 
way, have the volunteer record a few more ideas from 
the group, such as those shown to the right.  
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6. Explain that a way students can add linked ideas to their 

diagrams to start the organizational process is by using the 
Create tool. Have the volunteer click a symbol such as "Impact 
of usage” and then a point on the Create button where they 
want the new symbol to appear in relation to the originating 
symbol. Have the volunteer add a sub-idea the class suggests, 
such as "Effects on environment." 

 
 
 
 

 
7. Explain to students that adding visuals to diagrams will help students better understand 

concepts and help them to remember the details. It can also spur thinking and ideas, because 
they may need to think about the best way to represent a concept. They can search symbols 
or browse the built-in libraries in the Symbol Palette by clicking the Select Library button 
(down arrow) at the top of the Libraries tab. They can also view the different categories of 
symbols by clicking the Next Library or Previous Library buttons at the bottom of the 
Symbol Palette. For example, they could “drag and drop” the cycle symbol from the Basic 
library to the document near the “Ways to conserve” symbol and label it “Recycling.” They 
could also look at the Earth Science library for a symbol to represent "Lower CO2 emissions."   

	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
    
 
8. Demonstrate how students can search through Inspiration's extensive collection of online 

symbols. For example, to find a symbol for "Effects on environment," the volunteer could type 
"tree" in the box and hit Enter or Return. The tree can then be dragged to the “Effects on 
environment” symbol. Explain that as students continue to develop their diagrams they can 
also create symbols by importing images such as personal photographs or drawings. They 
could simply copy and paste or "drag and drop" the file or, if the image is already saved to 
their computer, they could choose Edit>Insert Graphic. 

 
9. Explain that students can create new links and quickly organize their diagrams with the Link 

tool on the Main toolbar. They merely click the symbol where the link should start, click the 
Link button, and then click where the link should end. For example, the subtopic "Ways to 
conserve" could be linked to "Recycling." With the Link tool still selected, "Benefits" could be 

Select 
Library 

Search 
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linked to "Improved air quality." Tell students that there are multiple ways to accomplish most 
tasks in Inspiration. Another way to create links is by dragging from one of the small diamonds 
or connection points on the edge of a symbol to another symbol. This can be faster than using 
the Link tool if only one or two links need to be drawn. For example, they could click on 
"Benefits" again and drag from one of the small diamonds in the middle of the edges to "Lower 
CO2 emissions."  

 
10. Explain that one way to show relationships between ideas is with Link Text. Have the 

volunteer click a link, such as the one between "Impact of usage" and "Effects on 
environment." Point out that when a link is selected, it has the outline of a text box around it. 
Tell students that this is for "linking" words or phrases and that adding text on a link defines 
the relationship between the ideas and is a feature of formal concept maps. Students can 
select from built-in Linking Phrases or add custom phrases by just typing in the text box. 
Have the volunteer click the Link menu>Linking Phrases and choose "includes" from the list 
of phrases. 

 
11. Point out how, without doing any research, the class has already created a basic diagram. 

However, students can add to and refine it as they embark on the research process, and they 
can use the Note tool to record more details. Tell students that for example, after researching 
the “Effects on the Environment” of using energy, they could learn about the emission of 
various greenhouse gases and increases in air and water pollution. These details could be 
added as additional symbols or simply added as a note on the existing symbol. Have the 
volunteer click on "Effects on environment” and click the Note button on the Main toolbar. The 
cursor appears in the open note. Ask students for suggestions about what they might learn, 
and have the volunteer type those into the note, such as "Greenhouse gases; air and water 
pollution.” 

 
12. Point out how the icon that appears when a note is closed is a Note Quick Control button; the 

button allows the note to be opened and closed with just one click. Open notes can also be 
hidden with the Close Note button. As students continue to add to their work, they can resize 
their notes for their learning style or viewing preferences. Demonstrate for students how the 
ability to resize and hide notes keeps diagrams “clean” and easy to understand. A note may be 
added to each symbol and may contain an almost unlimited amount of text.  

 
Note Quick Control 

 

                       Optimize  
Note Size 
 

 

Close 
Note 
	
  

Resize Note	
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13. Explain that once students have identified a focus for their research, they should 
show you their diagrams and get your approval of the topics before they start 
researching. Recommend that once they begin the research process, they 
should record the sources of information on their diagrams, and add Hyperlinks 
to Internet sources using the Hyperlink button on the Main toolbar. Optional: 
Show students how they can get help organizing their documents with the 
Arrange tool. 

 
 
14. Have the volunteer click the Outline View 

button to demonstrate how quick and easy 
it is to generate a linear outline and finish 
organizing their information and adding 
details. Explain that this is an important 
organizational step in the writing process, 
and that after they are happy with their 
outline and have added all the writing they 
can to it, they can click the Transfer button 
to continue the writing process and create a 
formal essay in a word processor. 

Transfer button: 

 
 
 
15. Have students get started with their own brainstorming and projects. Remind 

them to clear the topics they select with you before they begin the research 
process, and to ask if they have questions. Also, point out that more information 
is available from the Help menu, including a series of training videos: 
Help>Training Videos…. 

 
 

Adaptations / Extensions: 
• Students can make presentations to the class about what they learned 

using the Presentation Manager. Having students create a visual 
presentation with key talking points will help them to better understand 
and remember the information, in addition to helping the whole class to 
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learn about the topic. See the Creating Oral Presentations I and II lesson 
plans for more information about this process.  

• Complete diagrams can also be used as visual aids during presentations 
in Diagram View: subtopics can be hidden or viewed using the Subtopic 
Quick Controls  to allow focused attention on the topic being 
discussed. 

 
 

1 © Copyright 2011. National Governors Association Center for Best Practices and Council of 
Chief State School Officers. All rights reserved. Learn more online at 
<http://www.corestandards.org>. 
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Group	
  Project	
  Planning	
  
Lesson	
  Plan	
  

 
 
Subject Areas: All subjects 
 
Grade Level: 6 – 12 (ages 11 - 18) 
 
Time: At least one 45-minute class period; time outside of class as necessary 
 
Lesson Objective: 
Students will use Inspiration® to help them plan and successfully complete a project. 
  
Common Core State Standards1: 

College and Career Readiness Anchor Standards for Writing: 
Standard 6. Use technology, including the Internet, to produce and publish 

writing and to interact and collaborate with others. 
 

Overview: 
Use the Group Project Plan template with your students to help them successfully 
organize and complete a group project (Inspiration Starter>Templates>Thinking & 
Planning>Group Project Plan). Doing so will enable your students to more effectively 
identify project goals and steps needed to successfully complete the project. By 
consolidating all of the necessary information for a project on one visual diagram and 
using it throughout the course of the project, each group member can easily see what 
has been done and what still needs to be accomplished. 
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Preparation: 
• This lesson requires the Inspiration software application published by Inspiration 

Software, Inc. 30-day trials can be downloaded at 
<http://www.inspiration.com/Inspiration>. 

• This lesson requires the following Inspiration documents and templates: 
o Group Project Plan template, which can be accessed from inside 

Inspiration at Inspiration Starter>Templates>Thinking & 
Planning>Group Project Plan 

o Group Project Plan example, which can be accessed from inside 
Inspiration at Inspiration Starter>Examples>Thinking & 
Planning>Group Project Plan 

§ Please note: The templates and examples referenced in this 
lesson are web-based and only available if your computer is 
connected to the Internet. If you are not connected, you can 
create a similar example in Inspiration®. 

• Access to library resources and/or the Internet would also be helpful for student 
research. 

 
 
Lesson:   

1. Open the Group Project Plan template and demonstrate for students how it can 
be used to successfully complete a group project. Explain that students can add 
visual Symbols, as well as text, to their diagrams using the Symbol libraries. 
This is not essential to developing a successful plan, but the visual information 
can help group members focus on and remember important details about the 
project. 

 
2. Open the example file (Inspiration Starter>Examples>Thinking & 

Planning>Group Project Plan) so students have a better idea of what a finished 
project plan might look like. 
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3. Be sure to point out how additional information can be added in Notes. 
Demonstrate how notes that have been added to symbols can be shown by 
clicking the Note Quick Controls   in the upper-right corner of the symbol with 
the note. 

 
4. Demonstrate how students can view all notes at the same time, add additional 

notes and even whole sections of text, and reorganize them in Outline View. 
 
5. Organize students into groups of 2-4. Groups will then choose topics for their 

projects. You may want to provide a list of acceptable topics, or you may have 
groups choose topics and then submit their proposals for review. 

 
6. Tell student groups that they can use the diagram and outline throughout the 

course of the project to help them stay organized. They should also share it with 
you periodically so you can provide feedback and support throughout the 
process.  

 
7. Have student groups share the results of their projects by making presentations 

to the class using the integrated Presentation Manager. See the Creating Oral 
Presentations I and II lesson plans for more information about this process. A 
data projector or interactive whiteboard should be used, if one is available, to 
display graphics and visual talking points. 
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Adaptations / Extensions: 

• Complete diagrams can also be used as visual aids during presentations in 
Diagram View. Subtopics can be hidden or viewed using the Subtopic Quick 
Controls  to allow focused attention on the topics being discussed. 

 
• Students can transfer their project to a word processor using the Transfer tool to 

complete a written report about the project.  
 
• An alternate Project Plan template with guiding questions is also available to help 

students plan their projects: Inspiration Starter>Templates>Thinking & 
Planning>Project Plan. 

 
 

 

 
 
1 © Copyright 2010. National Governors Association Center for Best Practices and Council of 
Chief State School Officers. All rights reserved. Learn more online at 
<http://www.corestandards.org>. 

	
  


